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1 An overview of ELPLA-Boring 

 

ELPLA-Boring is used to edit and display graphically the boring logs (boring layers, soil 

material, foundation level and water table). The drawing of the boring logs can be displayed first 

on the screen, and then can be sent to the printer or plotter. The program draws the soil layers by 

different symbols according to the German Standard DIN 4023. 

 

ELPLA-Boring can also display the stress in soil under a specified point on the foundation with 

effective stress beside the corresponding boring log. The stress in soil is used to determine the 

limit depth of the soil layers. 

  

The drawings, if desired, can be saved as WMF-format files, in which they can be exported to 

other Windows applications to prepare reports, slide presentations, or add further information. 

 

 

2 Description of ELPLA-Boring 

 

ELPLA-Boring is a 32-bit, graphical software product that operates under Microsoft Windows 

9x/ NT/ ME/ XP. The common "what you see is what you get" of Windows applications makes it 

easy to learn how to use ELPLA-Boring, especially if you are already familiar with the Windows 

environment. 

 

The program package ELPLA consists of 7 separate programs. These can be run independently. 

Name and short description of the seven separate programs are given in Table H-1. 

 

The usage of the program is typically such that first data files are created describing a certain 

problem by ELPLA-Data, then the project problem is analyzed using ELPLA-Solver. Finally, 

results can be presented as graphical drawings, graphs and tables using the five separate 

programs ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor. 

 

Table H-1 Names and descriptions of the seven separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                         Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and Displaying boring logs graphically 

GEOTEC-Editor                               A simple text editor program 

 

In order to use ELPLA-Boring, first the user must define the project data by ELPLA-Data, and 

then must analyze by ELPLA-Solver. Table H-2 gives a list of files, which are read or created by 

ELPLA-Boring. The files can be classified in four groups. 
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Table H-2 Names of file groups 

Group     Saved from the program  

A    Main data files                       ELPLA-Data 

B    Boring files (*.BOR)         ELPLA-Boring 

C    Project data files                      ELPLA-Data 

D    Final result files                           ELPLA-Solver 

 

Further more, Table H-3 shows filenames, contents and groups of all files that may be read or 

created by ELPLA-Boring. 

 

Table H-3 Names and contents of files 

 

A Main data files 

Filename   Contents  

FIRMA   Firm header 

STEU                       Default directory for files that are saved by ELPLA 

NOFORMAT            Number formats  

UNITS    System of units 

 

B Boring files 

Filename   Contents 

LINEFORM. BOR               Line formats 

FONT. BOR                          Font data 

LEGENDE. BOR              Legend data 

PAINT. BOR                         Fill color data 

PLOTPAR. BOR              Plot parameters 

NODISPLA. BOR        Data of display values 

ORDINATE. BOR            Max. width data 

 

C Project data files 

Filename   Contents 

*. AUF         3 lines text to identify the project 

*. P21          Data of slab properties/ levels/ coordinates 

*. BAU         Soil properties 

*. LDH       Data of the limit depth 

 

D Final result files 

Filename   Contents 

*. LD1    Results of the limit depth 

The asterisk (*) matches any filename with the specified extension. 

 

 

3 Starting ELPLA-Boring 

 

Start ELPLA-Boring by clicking on the program icon. The introduction screen (Figure H-1) 

appears. 
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Figure H-1 Introduction screen of ELPLA-Boring 

 

The menu head of Figure H-1 contains the following 7 commands: 

 

- File 

- View 

- Graphic 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the seven menu commands, other sub-commands or options become 

available. The seven menu commands and their sub-commands are presented and described in 

the following paragraphs 4 to 11. 

 

 

4 File Menu 

 

The File Menu commands are: 

 

- Open 

- Make WMF-File 

- Print 

- Page setup 

- Files 1, 2, 3, 4 

- Exit 
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4.1 File Menu–"Open" command 

 

By "Open" command the current project is closed, if one is loaded, and an existing project is 

opened. Figure H-2 shows “Open” Dialog box used to open a specified project. 

 

 
Figure H-2 "Open project" Dialog box 

 

4.2 File Menu–"Make WMF-File" command 

 

By "Make WMF-File" command the drawing can be saved in a format that can be read by other 

programs. This feature allows you to include your drawing in reports and presentations and to 

enhance the drawing using other drawing or CAD software packages. The drawing can be 

exported in the Windows Metafile (WMF) format. 

 

Figure H-3 shows the “Save as” Dialog box used to export the drawing with the filename you 

wish to give the exported file, including extension and the directory in which to save the file. If 

the file name already exists, you may select to overwrite the existing file. 

 

 
Figure H-3 "Save as" Dialog box 

 

4.3 File Menu–"Print" command  

 

By "Print" command data and results can be graphically plotted or printed. Only the objects 

currently displayed on the drawing are printed. Figure H-4 shows "Print" Dialog box. The printer 

group box contains controls for selecting the printer and changing its properties. Use "Name" 

Combo box to select the printer and use "Properties" Button to set printer settings. The number 

of printing copies can be defined in "Copies" Input box. 
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Figure H-4 "Print" Input box 

 

4.4 File Menu–"Page setup" command 

 

By "Page setup" command the standard "Page setup" Dialog box can be displayed with options 

to specify the printer, page orientation, paper size, and paper source, as well as other printing 

options (Figure H-5). 

 

 
Figure H-5 "Page setup" Dialog box 

 

4.5 File Menu–"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 

 

4.6 File Menu–"Exit" command 

 

By "Exit" command the current project is closed and ELPLA-Boring is quitted, Figure H-6. 
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Figure H-6 "Exit" Message box 

 

 

5 View Menu 

 

The View Menu commands are: 

 

- Status bar 

- Tool bars 

 

5.1 View Menu–"Status bar" command 

 

"Status bar" command displays a status bar on the screen down. The status bar displays 

information about the progress of the current operation. 

 

5.2 View Menu–"Tool bars" command 

 

"Tool bars" command displays tool bars located just below the menu head. Tool bars contain 

icons of program menus. 

 

 

6 Graphic Menu 

 

The graphic menu is the main menu, used to display the specified drawing. The Graphic Menu 

command is: 

 

- Drawing boring logs/ Limit depth 

 

6.1 Graphic Menu–"Boring logs/ Limit depth" command 

 

By this command the boring logs (boring layers, soil material, foundation level and water table) 

can be displayed. The stress in soil under the foundation with effective stress can be displayed 

beside the corresponding boring log. The stress in soil is used to determine the limit depth of the 

soil layers. 

 

When "Drawing boring logs/ Limit depth" command is chosen, the selection Dialog box shown 

in Figure H-7 appears. In this Dialog box select the boring logs or the limit depths to draw, then 

click "OK" Button. Figure H-8 shows boring logs, while Figure H-9 shows a limit depth of soil 

layers. 
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Figure H-7 "List of borings" Dialog box 

 

 
Figure H-8 Drawing of 3 borings with multi-layers and different soil material 
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Figure H-9 Limit depth of the soil layers 

 

 

7 Options Menu 

 

The Options menu has the following commands: 

 

- Plot parameters 

- Display values 

- Scale 

- Title 

- Page No. 

- Copy 

 

7.1 Options Menu–"Plot parameters" command 

 

Figure H-10 shows the parameters, set as default values by the program, or specified by the user.   

 

- Color soil layers 

- Draw the water table 

- Simple drawing of boring logs 

- Setting soil colors according to DIN 4023 

- Display soil properties C, Phi and Nue 

- Color foundation 

- Draw foundation 

- Draw measurement bar 

- Color limit depth 

- Page with frame 
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Figure H-10 "Plot parameters" Dialog box 

 

7.2 Options Menu–"Display values" command 

 

By "Display values" command the values of the following items can be displayed, if desired, on 

the drawing (Figure H-11): 

 

- Label of the boring 

- Layer description 

- Layer depth 

- Display text of soil symbols 

- Measurement bar 

- Foundation 

- Water level 

- Limit depth 

- Stress value 

 

 
Figure H-11 "Display values" Dialog box 

 

7.3 Options Menu–"Scale" command 

 

By "Scale" command the scale of the drawing can be defined as shown in Figure H-12. The 

defaulted value for the scale factor is chosen to pass the active printer-paper format. 
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Figure H-12 "Scale" Dialog box 

 

7.4 Options Menu–"Title" command 

 

By "Title" command the text data (two line texts above the drawing and two line texts under the 

drawing) can be defined, Figure H-13.   

 

 

Figure H-13 "Title" Dialog box 

 

7.5 Options Menu–"Page No." command 

 

By "Page No." command the page No. can be defined, Figure H-14.  

 

 
Figure H-14 "Page No. " Dialog box 

 

7.6 Options Menu–"Copy" command 

 

By "Copy" command the current drawing can be copied in Metafile-Format to Clipboard. Then it 

can be inserted directly to other Windows programs such as Word, WordPerfect and AutoCAD. 
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8 Format Menu 

 

The Format menu has the following commands: 

 

- Line formats 

- Fill color 

- Max. width 

- Font 

- Legend 

 

8.1 Format Menu–"Line formats" command 

 

Color, style and thickness of drawing lines can be defined (Figure H-15). The way a line is 

drawn depends on the setting of the color and style properties. 15 different colors and 5 styles for 

line formats are available. The following list shows the available lines, which can be formatted: 

 

- Identification box 

- Page boundary 

- Boring boundary 

- Soil layer levels 

- Soil symbols 

- Groundwater 

- Foundation 

- Measurement bar 

- Limit depth 

 

 
Figure H-15 "Line formats" Dialog box 

 

8.2 Format Menu–"Fill color" command 

 

The following list shows available items, which can be filled with a specified color, Figure H-16: 

 

- Groundwater 

- Foundation 

- Measurement bar 

- Stress due to foundation 

- Stress from neighboring foundations 

- Stress from soil weight 
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Figure H-16 "Fill color" Dialog box 

 

8.3 Format Menu–"Max. width" command 

 

By "Max. width" command the maximum width for the drawing can be defined, Figure H-17. 

 

 
Figure H-17 "Max. width" Dialog box 

 

8.4 Format Menu–"Font" command 

 

By "Font" command the font size (Figure H-18) and font type (Figure H-19) for the drawing can 

be defined. 

 

 
Figure H-18 "Font size" Dialog box 
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Figure H-19 "Font type" Dialog box 

 

8.5 Format Menu–"Legend" command 

 

By "Legend" command height and width of legends can be specified as shown in Figure H-20. 

Also the legend that you wish to display can be chosen. 

 

 
Figure H-20 "Legend" Dialog box 

 

 

9 Window Menu 

 

The Window menu has the following commands: 

 

- Zoom in 

- Zoom out 

- Zoom window 

- Zoom % 

- Original size 

 

9.1 Window Menu–"Zoom in" command 

 

By "Zoom in" command the size of the drawing on the screen can be reduced. 
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9.2 Window Menu–"Zoom out" command 

 

By "Zoom out" command the size of the drawing on the screen can be increased. 

 

9.3 Window Menu–"Zoom window" command 

 

By "Zoom window" command the size of the drawing on a specified area can be increased. 

 

9.4 Window Menu–"Zoom %" command 

 

By "Zoom %" command the size of drawing on the screen can be specified (Figure H-21). 

Choosing "Zoom %" allows you to increase or decrease the size at which the drawing is 

displayed. Choosing 100% displays the drawing at its original size. Clicking on the percentage, 

changes the drawing size to the specified percentage. The drawing can be displayed at any size 

by typing the desired percentage in the specified Edit box. 

 

 
Figure H-21 "Zoom %" Dialog box 

 

9.5 Window Menu–"Original size" command 

 

The commands "Zoom in", "Zoom out" and "Zoom %" can change the size of drawing on the 

screen. The drawing can be displayed in its original size again using "Original size" command. 

 

 

10 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-Boring 

 

10.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide, Figure H-22. 
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Figure H-22 Menu "Contents" 

 

10.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 

 

10.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 

 

10.4 Help Menu–"About ELPLA-Boring" command 

 

The command, as shown in Figure H-23, gives information about ELPLA-Boring. 
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Figure H-23 Information form of ELPLA-Boring 

 

 

11 Tips and Tricks 

11.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table H-4 to Table H-11: 

 

Table H-4 Shortcut keys of menu head 

Shortcut keys  Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+g]     "Graphic" 

[Alt+o]     "Options" 

[Alt+t]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 
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Table H-5 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +o] or [Alt+f] then [o]  Calling command  "Open" 

[Alt+f] then [w]    "Make WMF-File" 

[Ctrl +p] or [Alt+f] then [p]    "Print" 

[Alt+f] then [u]    "Page setup" 

[Alt+f] then [1] Calling the first project from the last four loaded projects 

[Alt+f] then [2]  Calling the second project from the last four loaded projects 

[Alt+f] then [3]  Calling the third project from the last four loaded projects 

[Alt+f] then [4]  Calling the fourth project from the last four loaded projects 

[Ctrl+q] or [Alt+f] then [x]  Calling command "Exit" 

 

Table H-6 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [b]  Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [g]    "Tool bars-Graphic" 

[Alt+v] then [t], then [o]    "Tool bars-Options" 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [r]    "Reset Toolbar" 

 

Table H-7 Shortcut keys of Graphic-Command 

Shortcut keys Action 

[Alt+g] then [o] Calling command  "Drawing boring logs/ Limit depth" 
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Table H-8 Shortcut keys of Options-Command 

Shortcut keys  Action 

[Alt+o] then [l]  Calling command  "Plot parameters" 

[Alt+o] then [d]     "Display values" 

[Alt+o] then [s]     "Scale"  

[Alt+o] then [t]     "Title"  

[Alt+o] then [p]     "Page No."  

[Alt+o] then [c]     "Copy" 

 

Table H-9 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [l]  Calling command  "Line formats" 

[Alt+t] then [i]     "Fill color"  

[Alt+t] then [x]     "Max. width"  

[Alt+t] then [f]     "Font"  

[Alt+t] then [d]     "Legend" 

 

Table H-10 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [i]  Calling command  "Zoom in" 

[Alt+w] then [o]     "Zoom out"  

[Alt+w] then [w]     "Zoom window"  

[Alt+w] then [z]     "Zoom %" 

[Alt+w] then [r]     "Original size" 

 

Table H-11 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "New in ELPLA" 

[Alt+h] then [n]    "Short description of ELPLA" 

[Alt+h] then [a]     "About ELPLA-Boring" 
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11.2 Mouse 

 

By double-clicking the left mouse Button on a specified screen position, the user can obtain the 

almost menu of the program. 

 

- By double-clicking on legend, firm header, title or project identification, the 

corresponding menu appears 

 

- By double-clicking on scale in the identification box, "Scale"-Menu appears 

 

- By double-clicking on file name in the identification box, "Open"-Menu appears 

 

- By double-clicking on page No. in the identification box, "Page No."-Menu appears 

 

- By clicking the right mouse Button at any position on the screen, the user can also obtain 

the "Popup-Options"-Menu, Figure H-24 

 

 

 
Figure H-24 Menu "Popup-Options" 

 

 

12 Samples for graphical drawings using ELPLA-Boring 

 

ELPLA-Boring draws the soil layers by different symbols, where the same layers are presented 

with the same symbols for easy identification. For drawing the boring logs, the main symbols of 

German specification code are considered in ELPLA-Boring. It is possible to draw a total 

number of 46 soil and rock arts in boring logs according to German Standard DIN 4023.  
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Samples for symbols of soil layers according to German Standard DIN 4023 are presented in 

page P1. The pages P2 to P3 show also some graphical presentations of boring logs and limit 

depth according to Table H-12 and Table H-13. 

 

12.1 Graphical drawings of boring logs 

 

Table H-12 Boring logs 

Presentation                      Page 

Boring logs according to DIN 4023     P1 

Simple presentation of boring logs    P2 

 

12.2 Graphical drawings of limit depth 

 

Table H-13 Limit depth 

Presentation       Page 

Limit depth       P3  

 

 

13 Reference 

 

[1] DIN 4023. Baugrund- und Wasserbohrungen. Zeichnerische Darstellung der Ergebnisse 

 Beuth-Verlag, Berlin 1984 
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